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1. Getting started with Workflow Viewer
What is Workflow Viewer?

Workflow Viewer is an application that provides more functionality than is available in My Teamcenter
for workflows. In Workflow Viewer, you can:

• View any initiated workflow process, whether it is currently in process or has already completed.

• Edit an active workflow process, if you have write permissions.

Note:

Privileges granted with the WORKFLOW_adhoc_process preference are required to edit active
workflow processes.

• Perform workflow tasks.

• Override task actions.

You can view workflow processes from your worklist by selecting a task and selecting Process View
in the Viewer view. However, this method limits you to viewing only those workflow processes that
contain tasks assigned to you at the time the task remains in your worklist.

However, Workflow Viewer allows you to view the progress of a workflow process, even if you are not
a participating member of that particular workflow process. If you have read privileges for the workflow
process data, you can view any workflow process in the database, whether it is currently in process or
has already achieved its final status.

Note:

My Worklist in My Teamcenter is designed to provide a more streamlined process for progressing
through workflow processes to which you are associated. The worklist lists only those tasks that
you can perform or that you are assigned to track.

Example:

The following workflow process shows that the Change Admin I task is complete, that the
Author Technical Recommendation task has started, and that the remaining tasks are pending.
The name of the Check Change Type task (a Condition task) indicates whether the workflow
branches to either an author or change review board (CRB) business decision, depending on what
type of change object is the target of the workflow.
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Workflow Viewer view

Workflow Viewer uses the standard Teamcenter rich client interface. There are some panes, buttons,
menus, and menu commands that are specific to Workflow Viewer.

1. Getting started with Workflow Viewer
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1 Task hierarchy tree Displays the root-level workflow process, along with
its tasks and subtasks, in a hierarchical listing. Task
precedence in the task hierarchy tree is based on the order
in which the tasks were created.

2 Template manager pane Displays the name and description of the selected task.

3 Process flow pane Displays graphical views of the different levels of a
workflow process. You can view all the tasks in an entire
workflow process, or the subtasks in a task, or the subtasks
of subtasks, and so forth.

There are two ways you can view tasks and subtasks in Workflow Viewer.

• Select a task in the task hierarchy tree.

The process flow pane displays the selected task's subtasks in a graphical display.

• Double-click the desired task in the process flow pane.

The process flow pane advances down a level and displays the selected task's subtasks.

Workflow Viewer view
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Note:

Click F5 to refresh the currently selected task. Click F6 to refresh the entire page (and all tasks on
it).

Task Attributes

In the template manager pane, click Task Attributes  to display the Task Attributes pane.

Element Description

State Displays the task's state, such as Started, Pending, or
Completed.

Responsible Party Displays the responsible party for the task.

Named ACL Click to display the Named ACL dialog box.

Condition Query Displays when a Condition task is selected. The entry lists
the query selected to determine the true and false paths of
the Condition path. If a query has not yet been defined, it is
listed as empty.

Click the entry to display the Condition Query dialog box,
which you can use to change, modify, or delete the defined
query.

Condition Result Displays when a Condition task is selected. The entry lists
the required result of the query: either true or false.

1. Getting started with Workflow Viewer
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Element Description

Due Date Displays when the selected task contains a due date. The
entry lists the date by which the task must be completed.
If the task is not completed by the specified date, the task's
status changes to late, and the task becomes overdue.

Click Due Date to display the Due Date dialog box, which
you can use to set the date and time by which the task must
be completed. If the task is not completed by the specified
date, the task's status changes to late, and the task becomes
overdue.

Duration Displays when the selected task contains a defined duration.
The entry lists the length of time allowed for the completion
of the project. If the task is not completed within the
specified amount of time, the task's status changes to late,
and the task becomes overdue.

Click Set to display the Set Duration dialog box, which you
can use to set a length of time in which the task must be
performed. If the task is not completed within the specified
amount of time the task's status changes to late, and the
task becomes overdue.

Recipients Displays the names of users selected to receive program
mail when the selected task becomes overdue.

Click Set to display the Select Recipients dialog box, which
you can use to select users who will receive program mail if
the selected task becomes overdue.

Show Task in Process Stage List Displays if the Set Stage to Available check box is available.

Process in Background Indicates if the task is to be executed in the background.

Task Attachments

You can use the Attachments pane to view and manipulate attachments.

In the template manager pane, click Attachments  to display the Attachments dialog box.

Task Attachments
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This dialog box displays the objects attached to the workflow as targets or references.

• Replica proposed targets appear if they exist.

• You can cut, copy, or paste the objects with the respective buttons in the pane.

Task Handlers

In the template manager pane, click Task Handlers  to display the Handlers dialog box.

The Handlers values cannot be edited.

Item Description

Task Handler tree Lists folders representing each of the task actions. Each folder contains
the handlers associated with that task action.

Action handlers exist as direct descendants of the parent task action
folders. Rule handlers exist as children of rules.

1. Getting started with Workflow Viewer
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Item Description

Rules are direct descendants of task action folders.

Handler Type Specifies the handler types: action handler or rule handler.

Quorum Indicates how many rule handlers must be satisfied before the rule is
satisfied, therefore allowing the workflow process to proceed. When a
rule handler is selected, an integer appears representing the number
required.

Rule/Action Handler Selects the handler by name.

Argument/Value(s) When a predefined handler is selected, displays the predefined arguments
and values for the handler.

Help Selecting a handler from the Task Handler tree and clicking Help displays
the documentation for the selected handler.

Task signoffs

In the template manager pane, click Task Signoffs  to display the Signoff Profiles dialog box.

Item Description

Signoff Profiles tree Displays the name of the selected workflow process.

Signoffs Quorum Lists the number or percent of signoffs required for the task to complete,
and displays the Wait for Undecided Reviewers option that allows the
Review task to wait for all reviewers to submit their decisions before
completing and following the appropriate path.

Edit menu

The Edit menu contains commands used for editing workflow process properties.

Task signoffs
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Command Description

Template Lists the task templates available in Teamcenter.

Template→Task Workflow Designer default template setting. The Task
template is synonymous with the EPMTask template.

Template→Do Task Has two options if at least one failure path is configured:
Complete confirms the completion of a task and triggers
the branching to a success path. Unable to Complete
indicates the task is unable to complete, for various
reasons.

Uses the EPM-hold handler, which stops the task from
automatically completing when started.

Template→Review Task Uses the select-signoff-team and perform-signoff
subtasks, each of which has their own dialog box.

Wait for Undecided Reviewers is an option to set the
Review task to wait for all reviewers to submit their
decisions before completing and following the appropriate
path.

Template→Add Status Task Creates and adds a release status to the target objects of
the workflow process. It is a visual milestone in a workflow
process. There is no dialog box associated with this type of
task.

Template→Or Task Inserts an Or task into the workflow process. This task
continues the workflow process when any one of its
multiple task predecessors is completed or promoted. There
is no limit to the number of predecessors an Or task may
have.

Template→Acknowledge Task Inserts an Acknowledge task into the workflow process.
This task uses the Acknowledged and Not Acknowledged
subtasks, each of which has its own dialog box.

Template→Condition Task Inserts a Condition task into the workflow process. This
task requires that the succeeding task contains a EPM-
check-condition handler that accepts True, False, or any
string corresponding to custom result string configured on
the paths emerging from the preceding Condition task.

Template→Route Task Inserts a Route task into the workflow process. This task
uses the Review, Acknowledge, and Notify subtasks, each
of which has its own dialog box.

Template→Validate Task Inserts a Validate task into the workflow process. This task
give you the ability to respond to errors by providing an

1. Getting started with Workflow Viewer
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Command Description

alternate path which the workflow process traverses when
an error occurs.

Copy Workflow Process Copies the workflow process to the clipboard

Mode→Execute Initiates Execute mode to perform workflow process tasks.

Mode→Design Initiates Design mode to perform ad hoc process
modification.

View menu

The View menu contains commands used for viewing workflow process properties.

Command Description

Task Properties Opens a Task Properties dialog box that presents task information in a
concise format. Unlike Properties, Task Properties displays only relevant
information to the selected task.

Access Contains the user, group and role assigned to this task, if any. You
can open the ACL Control List and Extra-Protection dialog boxes for
reference.

Access control lists can be viewed and edited in Workflow Viewer. Create
an access control list from the Access Manager.

Audit→View Audit Logs
Note:

This command appears only if the TC_audit_manager preference
is set to ON and the TC_audit_manager_version preference is set
to 2.

Opens the Audit Log dialog box. Enter query data into the text boxes to
perform a search on any objects in the database. The search returns a
history of the actions taken on the defined objects.

Note:

Audit logs are based on site-defined audit definition objects.
Default settings of the Audit Manager provide audit definitions
for workflow and checkin/checkout events, allowing audit logs to
be automatically created for these functions. Site-defined audit

View menu

Workflows and Tasks on Rich Client, Teamcenter 2412  1-9
© 2025 Siemens



Command Description

definitions must be created to generate general workflow and
checkin/checkout audit logs.

Organization Displays a read-only organization chart.

Actions menu

The Actions menu contains commands used for setting the actions of tasks. All commands on the
Actions menu require privileged user status to function.

If a task is designated to process in the background, all actions except Perform and Assign are processed
in the background. The Perform and Assign action execute in the foreground.

Command Description

Perform Displays the Perform dialog box for the selected task. The contents of the
dialog box varies depending on the task selected.

Assign Reassigns the selected task to another user.

Start Manually starts a task. This command works only in certain circumstances.

Complete Manually completes a task, if it is in either the Started or Pending states.

Suspend Moves a selected task to a Suspended state. The only valid action from a
Suspended state is Resume.

Resume Moves a selected task from a Suspended state to the previous state.

Promote Places the selected task into a Skipped state, and starts the successor tasks
in the workflow process. For Review and Route tasks, the successor task
can be either along the approve or reject path, depending on the user’s
selection.

Demote Demotes a task is to retract workflow process control. The selected task
changes from a Started state to a Pending state. To demote subtasks and
restart the predecessor tasks, an EPM-demote handler must be built into
the selected tasks template.

Stand-In Allows you to perform the task while allowing the original user to retain
control.

Abort Cancels a workflow process and exits without workflow process
completion.

Claim Task Allows you to reassign a task to yourself.

1. Getting started with Workflow Viewer
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Go menu

The Go menu contains commands used for maneuvering through a workflow process.

Command Description

Up a level In the task hierarchy tree, opens the parent task of the currently selected
task. The remaining views are initialized accordingly.

Down a level The currently selected task in the process flow pane is selected in the task
hierarchy tree and the remaining task views are initialized accordingly.

If there is no task selected in the process flow pane, the first subtask of
the currently selected task in the task hierarchy tree is selected and the
other task views are initialized accordingly.

Top level In the task hierarchy tree, opens the root task of the workflow process.

Workflow Viewer buttons

Button Description

Task Properties Displays the name, description, attributes, and handlers of the selected
task.

Open By Name Searches for a workflow process by name.

MRU Displays the mostly recently opened workflow processes.

Task Attributes Displays and opens for edit the named ACL, task type, and quorum
requirements for the selected task.

Task Attachments Displays and opens for edit the attachments to the selected task.

Task Handlers Displays and opens for edit task handlers for the selected task.

Task Signoffs Displays and opens for edit the group, role, quorum, and number of
reviewer requirements for the selected task.

Task Inserts an empty task with no handlers into the workflow template for you
to customize.

Perform Task Starts the required work for the task. For example, to complete a select-
signoff-team task, the responsible party clicks the Perform Task button
and then selects team members meeting the defined group and role
requirements to complete the task.

Do Task Inserts a Do task into the workflow template. This task has two options, if
at least one failure path is configured: Complete confirms the completion

Go menu
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Button Description

of a task and triggers the branching to a success path. Unable to
Complete indicates the task is unable to complete, for various reasons.

Review Task Inserts a Review task into the workflow template. This task uses the
select-signoff-team and perform-signoffs subtasks, each of which has
its own dialog box.

Full Participation Required is an option that allows the workflow
designer user to set the Review task to wait for all reviewers to submit
their decisions before completing and following the appropriate path.

Add Status Task Inserts an Add Status task into the workflow template. This task creates
and adds a release status to the target objects of the workflow process.
It is a visual milestone in a workflow process. There is no dialog box
associated with this type of task.

Or Task Inserts an Or task into the workflow process. This task continues the
workflow process when any one of its multiple task predecessors is
completed or promoted. There is no limit to the number of predecessors
an Or task may have.

Acknowledge Task Inserts an Acknowledge task into the workflow template. This task uses
the Acknowledged and Not Acknowledged subtasks, each of which has
its own dialog box.

Condition Task Inserts a Condition task into the workflow template. This task requires
that the succeeding task contains an EPM-check-condition handler that
accepts a Boolean value of either True or False.

Route Task Inserts a Route task into the workflow template. This task uses the
Review, Acknowledge, and Notify subtasks, each of which has its own
dialog box.

Validate Task Inserts a Validate task into the workflow template. This task gives you
the ability to respond to errors by providing an alternate path which the
workflow process traverses when an error occurs.

Up a Task Level Displays the task one level higher than the current task.

Down a Task Level Displays the task one level lower than the current task.

1. Getting started with Workflow Viewer

1-12  Workflows and Tasks on Rich Client, Teamcenter 2412
© 2025 Siemens



2. Viewing workflows
Workflow terminology

In Teamcenter, workflows are processes based on process templates that are composed of tasks.

Term/Concept Description

Process A process is the automation of a business procedure, describing the
individual tasks and task sequences required to complete a business
procedure.

Process template Workflow processes are created based on a process template, which
functions as a blueprint of the workflow process. A specific workflow
process is defined by placing workflow and/or change management tasks
in the order they should be performed. Process templates are created
using Workflow Designer.

Tasks The fundamental building block used to construct a process is a task.
Each task defines a set of actions, rules, and resources used to accomplish
that task. User actions cause tasks to move from one state to another,
and as a result, the overall process moves forward or backward.

In a workflow, actions are assigned or allowed depending on the type of user.

User Description

Responsible party A responsible party is the user responsible for performing a particular
task within a workflow process. While performing the task, the
responsible party can reassign responsibility of the task to another user.
If the task is reassigned to a user other than the workflow process owner,
the workflow process owner is no longer the responsible party.

Privileged user A privileged user is the responsible party, the process owner, or a
member of a system administration group.

Process owner A process owner is the user who initiated the workflow process. The
process owner is also known as the process initiator. When the workflow
process is initiated, the process owner becomes the responsible party for
the workflow process; the root task of the workflow process is placed in
the process owner's worklist.

Whenever any task in the workflow process is not explicitly assigned to
another user, person or resource pool, the responsible party for the task
defaults to the process owner.
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Viewing task flow

Task flow is both the order in which tasks are placed in the workflow process and the method by which
the tasks are linked. View the task flow of a workflow process in the process flow pane. Links determine
the sequence in which tasks are executed.

For example, in the following workflow process, the Update Timesheet task starts first. When
it completes, the Review Timesheet task starts. This second task is a Review task, a container
task containing both the select-signoff-team and perform-signoffs tasks. When both subtasks are
completed, the workflow process reaches the Finish node and completes.

Success paths are indicated by a solid line. Failure paths are indicated by a dotted line. All paths are
configured in the workflow template at design time.

Failure paths provide an alternate course for the workflow process to follow when:

• A task is rejected.

• The user determines that the task cannot be completed.

• There is an error.

Failure paths represent different results for different tasks.

Task Failure option

Do Set to Unable to Complete

Review Set to Reject

Route Set to Reject

Condition Set to Unable to Complete

Validate Set to Error Path

EPM Set to Unable to Complete

In the following workflow process, the task flow follows the success path from Review Timesheet
to Revised OR Accepted when the number of reviewers defined by the quorum setting approve the
timesheet.

2. Viewing workflows
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Alternatively, the task flow follows the failure path from the Review Timesheet task to Revise
Timesheet when less than the number of reviewers defined by the quorum setting approve the
timesheet. This failure path allows the specified user to revise the timesheet based on reviewer
comments.

Task flow can also flow backward. The following workflow process uses a Validate task to ensure that
the correct types of target objects are always selected for a design review.

The task flow begins with a Do task, which sends the process initiator instructions to ensure the
workflow process was initiated against the correct target objects.

When the Select Proper Targets task completes, the workflow process continues to the Validate
Targets task, which, in this example, is configured to confirm that the correct target objects were chosen
for the workflow process. If the target types are correct, the process flow continues to the Review Plan
task. If not, the process flow moves backward to the Select Proper Targets task.

The process initiator must once again complete the Do task. The process flow continues to loop until the
correct target types are chosen.

Viewing task flow
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Determining a task's responsible party

Each task within a workflow process has a responsible party. The responsible party is the person
responsible for performing the task.

When viewing workflow processes in Workflow Viewer, you can determine the responsible party by
placing the cursor over the Responsible Party  button in the upper-right corner of each task.

Note:

In the case of perform-signoffs tasks, multiple users are members of the signoff team. Each
member is responsible for performing a signoff, but none need be the responsible party. By
default, the responsible party for this task is the process initiator. But this responsibility may be
configured differently at your site. The responsible party has oversight over all signoffs and has the
responsibility to oversee the completion of all perform-signoffs tasks. To this end, the responsible
party has permission to delegate the signoff of any signoff team member.

Opening a workflow process from an object

You can open workflow processes in Workflow Viewer by selecting any object associated with a
workflow process and choosing the Send To command from the shortcut menu to send the object
to Workflow Viewer.

• You can select an object from anywhere within the rich client.

• The act of sending the object to Workflow Viewer opens the workflow process, letting you view all
aspects of the workflow process.

• This method is useful for viewing the most current workflow associated with the selected object.

For example, perhaps you worked on a subassembly last week. A review process has since been initiated
for the subassembly. You are not on the review team but want to read the review comments. Having
recently worked on the subassembly, the object is still in your Home folder.

You can:

1. Right-click the subassembly and choose the Send To command to send the subassembly to
Workflow Viewer.

2. Viewing workflows
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2. Choose the Actions→Perform command to open the Perform Signoff dialog box.

3. Click the Browse Signoffs tab to read all reviewer comments.

Note:

Because you are not a member of the review team, you cannot perform the signoff.

In another example, you may want to use the Teamcenter search feature to identify all objects of a
specified type currently in a workflow process and then send each object Workflow Viewer to view them
in detail.

1. In the Search view, select WF – Object in Process from the System Defined Searches folder.

2. Select which type of object you want to find in active workflow processes, such as item revisions or
master parts.

3. Run the search, and then select objects one by one from the Search Results tab, using the Send To
command to send the objects to Workflow Viewer, which opens the associated workflow.

Open a workflow process from an object

1. Select a Teamcenter object that is, or has been, involved in a workflow process using one of the
following methods:

• Select an object from your worklist.

• Search for in-process objects using the WF-Object in Process defined search.

• Select an object from any assembly.

Note:

In-process objects are indicated by the  symbol.

Objects already granted release status are indicated by the  symbol.

2. Right-click the selected object and choose Send To→Workflow Viewer.

The Workflow Viewer view is opened, and the workflow process displays in the process flow pane.

By default, the workflow process displays in Execute mode. This mode allows you to view all
workflow process details. If the workflow process contains any tasks assigned to you, you can
perform them in Execute mode.

The Design mode is used by privileged users to modify active workflow processes.

Open a workflow process from an object
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Opening a workflow process from a reference

You can view current and previous workflows and workflow subprocesses associated with an object.

• Perform a Where Referenced search on any object ever associated with a workflow process.

• Use the Send To command to send any of the referenced workflow processes to Workflow Viewer.

For example, perhaps you worked on a subassembly last year and since then several workflow processes
have been initiated against the subassembly.

To see all the workflow processes associated with the subassembly:

1. Use the Search command to find the subassembly.

2. Click the Impact Analysis tab

3. Perform a Where Referenced search on the subassembly.

Note:

Set the depth of the reference search to cover all levels to ensures that all workflow processes
associated with the subassembly are displayed.

4. Select and open any workflow process from the Where Referenced search results by selecting the
workflow process and using the Send To command to send the subassembly to Workflow Viewer.

Open a workflow process from a reference

1. Select a Teamcenter object that is, or has been, involved in a workflow process using one of the
following methods:

• Select an object from your worklist.

• Search for in-process objects using the WF-Object in Process defined search.

• Select an object from any assembly.

Note:

In-process objects are indicated by the  symbol.

Objects already granted release status are indicated by the  symbol.

2. Click the Impact Analysis tab.

2. Viewing workflows
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3. Set the Where box to Referenced and the Depth box to All Levels.

All references to the selected object display in the bottom pane, including all workflow processes.

4. Open any workflow process by right-clicking the workflow object from the Where Referenced
results and choosing Send To→Workflow Viewer.

The Workflow Viewer view is opened, and the workflow process appears in the process flow pane.

By default, the workflow process displays in Execute mode. This mode allows you to view all
workflow process details. If the workflow process contains any tasks assigned to you, you can
perform them in Execute mode.

The Design mode is used by privileged users to modify active workflow processes.

What are workflow subprocesses?

Subprocesses are child workflow processes of a parent workflow process. You can create subprocesses
while performing tasks from your worklist.

Note:

If the parent process is dependent on the subprocess, the parent process cannot complete until
the subprocess completes. For example, if the EPM-create-sub-process action handler is used
to create subprocesses for multiple targets from a parent process, the parent processes are
dependent on the subprocesses.

A typical scenario is one in which you receive a task in your worklist that is dependent upon the
completion of an additional workflow process. You decide to create a workflow subprocess to track the
work which must be completed before you can complete the task in the parent workflow.

Subprocesses are created in two locations:

Parent
workflow
templates

Administrators can configure workflow templates to create subprocesses. For example,
a parent workflow template can be configured to automatically launch subprocesses for
each target of the parent workflow.

My Worklist End users can create ad hoc workflow subprocesses while performing tasks from
their worklist or from Workflow Viewer. Generally, any user can create a workflow
subprocess from a task within their worklist. This functionality is not limited to
privileged users.

When you create a workflow subprocess from an in-process task in your worklist, you
create a dependency between the selected task in the parent process and the newly
created subprocess. The targets of the active parent workflow process are carried over
if you check the Inherit Targets box. If a subprocess is created from an in-process task,
the task cannot complete until the subprocess completes.

What are workflow subprocesses?
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Note:

The behavior of the Inherit Targets box is determined by the
EPM_multiple_processes_targets and EPM_sub_process_target_inheritance
preferences.

Regardless of how these two preferences are set to control the inheritance of
target objects from the parent process, users can always manually add or remove
targets from subprocesses.

This pseudo folder Independent Sub-Workflows displays subworkflows identified from the property
epm_subprocesses. Subworkflows are presented in no particular order, nor can their order be
controlled.

Note:

Workflow subprocesses are not always dependent on parent processes. The
WRKFLW_skip_abort_on_sub_process preference is honored only for independent subprocesses.

Set the WRKFLW_skip_abort_on_sub_process preference to true to skip abort of subprocess
when a parent process is aborted.

If there is a dependency from a parent process to its subprocesses, aborting the parent will abort
the dependent subprocesses, irrespective of the value of the preference.

The default value is false which will abort the subprocesses along with parent process.

Create a workflow subprocess

You can create workflow subprocesses while performing tasks from your worklist or Workflow Viewer.

To create workflow subprocesses while performing tasks from Workflow Viewer:

1. In the Task hierarchy tree, select the task in the existing workflow from which you want to create a
subprocess.

The task you select becomes dependent upon the workflow subprocess. It cannot complete until
the workflow subprocess completes.

2. Right-click the task and choose Create New Workflow Sub-Process.

The New Sub-Process dialog box appears.

3. Type a name for the process in the Sub-Process Name box.

4. Type a description to identify the process in the Description box.

2. Viewing workflows

2-8  Workflows and Tasks on Rich Client, Teamcenter 2412
© 2025 Siemens



5. To include process templates currently under construction in the Process Template list, select the
Show Under Construction Templates check box.

6. (Optional) Select a Process Template Filter option, if available.

Caution:

Process Template Filter functionality has been deprecated as of Teamcenter 11.2, and is
turned off by default. This functionality is replaced by Business Modeler IDE conditions used
to associate templates.

• To display all available process templates in the Process Template list, select All.

• To display only those process templates assigned to your group in the Process Template list,
select Assigned.

7. Click the Process Template list to view available workflow process templates and make a selection.

Your selection determines the workflow that is initiated as a workflow subprocess.

8. (Optional) Select the Inherit Targets  check box if you want the new workflow subprocess to
include all the targets of the parent workflow process.

9. (Optional) Click the Attachments tab to view or assign target and reference attachments.

10. (Optional) Click the Process Template tab to view the process template selected as the basis of the
new process.

11. (Optional) Assign all tasks in the process.

a. Click the Assign All Tasks tab.

b. Select a list from the Assignment Lists list.

Teamcenter applies the assignment list to the tasks in the process. Users are displayed as
nodes in the process tree and the action assigned to the user is displayed to the right of the
tree under the Actions heading.

Note:

The select-signoff-team and perform-signoffs subtasks associated with Route,
Review, and Acknowledge tasks are not displayed in the tree.

c. Assign users:

Create a workflow subprocess
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A. Expand the task node in the tree to begin to assign the responsibility of performing each
task to users.

If the selected task requires users, or users of a specific/group role profile, to perform the
task, the Users node or Profiles node appears under the task.

B. Select the task, or if available, the Users or Profiles node within the task.

C. Use the Organization and Project Teams trees to select users to be responsible for
performing the selected task.

You can search for a specific user, group, role, or combination.

D. Alternatively, use Resource Pool Options to select a resource pool to be responsible for
performing the task.

E. The action that the selected users are responsible for display next to the Action option.

The action list is based on the task type. For example, if a Route task is selected, the
Review, Acknowledge, and Notify actions are displayed. If a Review task is selected,
only the Review action is available; if an Acknowledge task is selected, only the
Acknowledge action is available.

F. Click Add.

The system displays the user information and action assigned to that user beneath the
task node in the process tree.

G. Repeat the previous steps to continue to assign user responsibility for performing other
tasks in the tree.

d. (Optional) If the selected task is a Review or Acknowledge task, you can set the approval
quorum values for the tasks in the Review Quorum or Acknowledge Quorum box.

e. (Optional) If the selected task is a Review or Acknowledge task, specify that you do not
want the task to complete until all reviewers perform their signoff by selecting the Wait For
Undecided Reviewers check box. If you do not select this check box, the task completes as
soon as the approval quorum is satisfied.

f. (Optional) To save modifications to the process assignment list, select the Save Modifications
Back to List check box.

Note:

You can only save modifications to personal process assignment lists. Shared lists can be
modified, but the changes cannot be saved.

2. Viewing workflows
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12. Click OK to initiate the process.

Note:

Click Cancel at any time to cancel the operation without initiating a process.

Opening a workflow subprocess in Workflow Viewer

Subprocesses are child workflow processes of a parent workflow process. Users can create ad hoc
subprocesses while performing tasks from their worklist or Workflow Viewer. When created in this
manner, parent workflow processes are dependent upon subprocesses; they cannot complete until the
subprocess completes.

Note:

You can create both dependent and nondependent subprocesses from the worklist. A
nondependent subprocess does not have tasks that depend on the subprocess’s completion.

A typical scenario is one in which a user receives a task in his worklist that is dependent upon the
completion of an additional workflow process. The user creates a workflow subprocess to track the work
which must be completed before he can complete the task in the parent workflow.

The existence of a subprocess within a parent process is indicated by a yellow circle outlined in white.
For example, the following workflow indicates that the select-signoff-team task within a parent process
is associated with a subprocess.

Display the list of associated subprocesses by clicking the subprocess button. Click a name in the list
to open the subprocess in Workflow Viewer. (Double-clicking the subprocess button opens the first
subprocess in the list.)

Open a subprocess

From a parent workflow process displaying the subprocess button , open a subprocess using one of

the following methods:

Opening a workflow subprocess in Workflow Viewer
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• Click the subprocess button to display the list of associated subprocesses. Click a subprocess in the list.

• Double-click the subprocess button. The first subprocess in the list opens.

The parent process closes and the selected subprocess appears in the process flow pane.

In the subprocess, the parent workflow process button  appears at the locations the parent process

encompasses the workflow subprocess.

Opening a parent workflow process in Workflow Viewer

Workflow processes can be associated with child workflow processes. Users can create subprocesses
while performing tasks from their worklist or Workflow Viewer. When subprocesses are created in this
manner, the parent workflow processes are dependent upon subprocesses; they cannot complete until
the subprocess completes.

The existence of a parent workflow process is indicated within a subprocess by a white circle outlined
in yellow. For example, the following workflow process indicates that the entire workflow is a child
workflow process related to a parent workflow process.

Open a parent workflow process by double-clicking the parent process button.

Open a parent process

In a parent workflow process, the workflow subprocess button  appears at the location the

workflow subprocess occurs.

• To see a list of parent process nodes for a workflow subprocess, click the parent workflow process

button .

• To open a parent process, double-click the parent workflow process button .

The workflow subprocess closes and the parent workflow process appears in the process flow pane.

2. Viewing workflows
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View signoff team profiles

The Signoff Profiles pane can be displayed only if a select-signoffs-team task or a Route task is
selected.

Note:

The Signoff Profiles pane is unavailable for the Acknowledge subtask within the Route task
template.

1. Click Task Properties  on the toolbar.

The Task Properties dialog box displays. The name of the selected process template or task
template is listed in the Name box. Task instructions, if any, are displayed in the Instructions box.
The task's attributes display by default. Other property tabs are available in this view.

2. Click the Signoff Pane  tab.

The number or percent of signoffs required for the task to complete is listed. Also, the Wait for
Undecided Reviewers check box is displayed.

3. Click Close.

View signoff team profiles
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3. Tasks you can perform
Performing tasks in Workflow Viewer

You can perform any interactive task from Workflow Viewer that is assigned to you and currently active.
In other words, any task you can perform from My Worklist you can perform from Workflow Viewer.

Your My Worklist view is streamlined to display only tasks that are ready to be performed. Because
Workflow Viewer displays the entire workflow process, selecting tasks to perform requires a basic
understanding of the different task statuses in a workflow process.

Example:

The following workflow process indicates that the Change Admin I task is complete . You can
no longer perform this task. The Author Technical Recommendation task has started  and can
be performed.

The Author Technical Recommendation task is a Review task. Review tasks are container
tasks; they always contains two subtasks, a select-signoff-team subtask and a perform-signoffs
subtask.

You must expand the Review task to view the status of the two subtasks and determine which
subtask is ready to be performed. You can expand container tasks from either the task tree or by
double-clicking the task within the process flow pane.
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Expansion method
Container task Container task expanded

Task tree

Process flow pane

Using either method to expand the Author Technical Recommendation task reveals that the
select-signoff-team task is started and can be performed, and that the perform-signoffs task is
pending and cannot yet be performed.

Perform a Do task in Workflow Viewer

To perform a Do task, follow the instructions in the Instructions box. Select Done when the task criteria
is met. To complete a Do task that has reached a Started state, perform the following steps:

1. Click the Do Task to be completed, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the Do task,
you can create a subprocess from this task. The subprocess must complete before the Do task can
complete.

3. Click Perform Task  on the toolbar.

The Perform Do Task dialog box appears.

4. Review the task instructions listed in the Instructions box.

5. (Optional) Review any contents in the Process Description box. If necessary, type additional
information into the box.

6. Complete the task instructions.

7. (Optional) In the dialog box, type any comments regarding the task in the Comments box.

8. Select Complete.

If the task is configured with a failure path, you can also select Unable To Complete.

3. Tasks you can perform
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9. Type your user password in the Password box.

This box appears only if user authentication is required for the completion of this task. This
authorization is determined by the creator of the process template.

10. Click OK to save the changes to the database and close the dialog box.

11. Click Cancel at any time to cancel the operation without making changes to the database.

Perform a Condition task manually in Workflow Viewer

To perform a Condition task, follow the instructions in the Instructions box. The instructions should
pose a question or define a set of parameters that can be answered. Unset is the initial value of the
task, which must be changed. The task cannot complete or the workflow process continue, while the
task remains set at Unset. If the Condition task is configured with custom paths (paths that are set
with result values other than true and false), the available options will reflect these custom results. The
Unable To Complete option displays on Perform Condition Task dialog box, if the Condition task is
configured with a failure path.

Note:

An automatic Condition task is configured to proceed during the workflow process. It acts as a
visual milestone in the workflow process. There is no action for a user to perform and no dialog
box associated with the automatic Condition task.

1. Select the Condition task to be completed, either in the task hierarchy tree or the process flow
pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the Condition
task, you can create a subprocess from this task. The subprocess must complete before the
Condition task can complete.

3. Click Perform Task  on the toolbar.

The Perform Condition Task dialog box displays.

4. Complete the task instructions listed in the Instructions box.

5. (Optional) Review any contents in the Process Description box. If necessary, type additional
information into the box.

6. Set Task Result to true or false, based on the requirements listed in the Instructions box. If the
Condition task is configured with custom paths (paths that are set with result values other than
true and false), the available options reflect these custom results. This setting determines whether
the workflow process continues along the true or false flow line branching off the Condition task.

Perform a Condition task manually in Workflow Viewer
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Setting the condition path to unset prevents the task from completing and pauses the workflow
process.

7. Select Complete.

If the task is configured with a failure path, you can also select Unable To Complete.

8. Type your user password in the Password text box. This text box appears only if user authentication
is required for the completion of this task. This authorization is determined by the creator of the
process template.

9. Click OK to save the changes and close the dialog box.

10. Click Cancel at any time to cancel the operation without making changes.

Note:

You can set a Condition task result while it is still in a Pending state.

• Performing a manual Condition task while it is pending prevents the task from appearing in the
assigned user's worklist.

• Performing an automatic Condition task while it is pending preempts the query results,
allowing you to override the confines of the query and manually set the task to true or false.

If you perform a Condition task while it is still in a Pending state, you can return to the task and
reset the true/false/unset setting at anytime until the task reaches a Started state.

Perform a Route task in Workflow Viewer

A Route task is the electronic equivalent of a routing sheet; the task is used to assign different
responsibilities for the same task to multiple users. After you complete a Route task, the users are
notified of their tasks by Teamcenter mail.

1. Select the Route task, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the Condition
task, you can create a subprocess from this task. The subprocess must complete before the
Condition task can complete.

3. Click Perform Task  on the toolbar.

The Select Signoff Team dialog box appears.

4. Click Users in the Signoff Team tree.

3. Tasks you can perform
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The right pane displays the Organization pane.

a. Search or select a user from the Organization or Project Teams tree.

In the Organization tree, you can search for a specific user, group, role, or combination.

You can assign a resource pool to the task in the Resource Pool Options.

b. Select a group, role, or user to whom the task will be assigned.

c. Select either Review, Acknowledge, or Notify from the Action list.

d. Click Add.

Teamcenter displays the user information and action assigned to that user beneath the task
node in the process tree.

e. Repeat the previous steps to add additional users and task responsibilities.

5. If you want to use address lists to add other users, click Address Lists in the Signoff Team tree.

The right pane displays the Address Lists pane.

a. Select a list from the Address Lists list.

b. Select either Review, Acknowledge, or Notify from the Action list.

c. Click Add.

Teamcenter displays the address list information and action assigned to that address list
beneath the task node in the process tree.

d. Repeat the previous steps to add address lists.

6. Optionally, modify or set the approval quorum value for the Review and Acknowledge tasks in the
Review Quorum and Acknowledge Quorum boxes.

7. If you want the workflow process to wait for all reviewers before continuing, select the Wait for
Undecided Reviewers check box.

8. Select the Ad-hoc done check box to indicate you have completed adding signoff team member
assignments to this task.

9. Click OK.

Perform a Route task in Workflow Viewer
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Perform a Custom task in Workflow Viewer

To perform a Custom task, complete the form or instructions provided. Custom tasks usually involve
custom forms that are unique to your company's processes. Incorporating company forms into a custom
task further automates the workflow process.

1. Select the Custom task in either in the task hierarchy tree or the process flow pane.

In the process flow pane, the custom task's subtasks appears.

2. Click Perform Task  on the toolbar.

The Perform dialog box for the selected custom task appears.

Note:

The Perform dialog box for the selected custom task varies depending on the form and/or
other tasks the system administrator attaches to the selected task.

3. Complete the steps listed in the dialog box.

4. Select Complete.

If the task is configured with a failure path, you can also select Unable To Complete.

5. Click Close or OK.

Note:

If the form attached to the Custom task is a simple form, the task may not automatically move to
the Complete state when you click the Finish/Close button.

Reassign a task in Workflow Viewer

If you are the responsible party or a privileged user, you can reassign any task that has not already been
started.

For example, if you are the initiator of a process, the tasks of selecting a signoff team and performing
signoffs are automatically assigned to you. You may want to reassign one or both of these tasks to
another user.

Note:

• You can only reassign a task to another user who meets the group and role criteria defined for
the selected task.

3. Tasks you can perform
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• If you want to reassign the task to yourself, use the Claim Task menu command instead.

• Your administrator can change who can reassign a task using the Fnd0AssignTaskPrivilege
Business Modeler IDE condition to restrict the reassignment of workflow tasks.

1. Select the task to be reassigned.

You can select it in either in the task hierarchy tree or the process flow pane. In the process flow
pane, the selected task's subtasks appear.

2. Choose Actions→Assign.

The Assign Responsible Party dialog box appears.

3. If the Responsible Party entry contains a link, you can reassign the responsible party for this
signoff task. Reassign the responsible party by clicking the link next to this entry.

The Assign Responsible Party dialog box appears. The Organization and Project Teams lists
display the available groups, roles, and users to which you can reassign the task.

You can search for a specific user, group, role, or combination.

4. Select the desired group, role, or user. You can only reassign the selected task to a user who meets
the group and role criteria required by the task.

5. (Optional) Reassign multiple tasks, as follows:

a. Click Show Tasks.

The system displays the pending tasks associated with the selected process in a tree structure.

b. Select individual tasks to be reassigned, or click the Select All the Tasks button to select all
displayed tasks.

Note:

Click the Clear the Selection button to clear selections you have made in the tree.

6. Click OK or click Cancel at any time to cancel the operation without making changes to the
database.

Reassign a task in Workflow Viewer
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Claim a task in Workflow Viewer

Note:

You can perform the task immediately without first claiming it. This is useful for tasks you can
perform right away.

You can claim a task from a resource pool or another user whose worklist you have access to. This
reassigns the task to you and makes you the responsible party. This is a simpler way of reassigning a task
to yourself using the Assign action.

1. Open a process in Workflow Viewer.

2. Select the task in the workflow you want to claim.

3. Choose Actions→Claim Task.

4. If the task is assigned to a single user, such as a Do task or select-signoff-team task, click OK in the
confirmation dialog box.

If the task is assigned to multiple users, such as a perform-signoffs task, the Claim Perform
Signoff dialog box appears.

5. In the Claim Perform Signoff dialog box, select the user you want to claim the task from and click
Claim.

If the Claim button is not active after selecting a user, you cannot claim the task from that user.

The task appears in your worklist, and you become the responsible party for the task.

Note:

When you claim a perform signoff task, the signoff is assigned to you. The responsible party for the
task, however, remains unchanged.

Move a task in My Worklist

Tasks in My Worklist can be assigned Priority value and then sorted based on that.

Do the following:

1. In Teamcenter, set TC_Enable_Implicit_CO preference to true.

2. Click the Details tab.

3. Tasks you can perform
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3. Click the inverted triangle icon in the upper-right corner, then select Column.

4. Search for the string property fnd0Priority and add it to list of displayed columns.

5. Click Apply.

6. Click the Priority field and edit the priority (alphanumeric values are accepted) for each of the tasks
that need to be sorted.

Move a task in My Worklist
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7. Once the priority field is filled, click the column heading to sort it in ascending/descending order.

Note:

The tasks are sorted in the Details tab as per priority. However, the tasks remain in their
default creation date-based sorting order under the Tasks to Perform folder.

3. Tasks you can perform
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4. Selecting a signoff team
Selecting a signoff team in Workflow Viewer

To perform a select-signoff-team task, the responsible party selects users to be members of the signoff
team. Each member of the signoff team is responsible for reviewing and signing off on the attached
target objects. They do this using the perform-signoffs task, which is sent to their worklist as soon as
the signoff team is selected.

There are three methods of selecting a signoff team.

Selection method Description

Profiles Select the specified number of users to be members of
the signoff team or use a resource pool. Each user must
meet the group and role requirements of the profile.

In this example, you must select one user from the
Change Specialist group, of any role. (The * is
a wildcard.) You must select three users from the
Engineering group with the role of Designer. (Profile
requirements can be met using resource pools, as well
as individual members.)

The OK button in the Select Signoff Team dialog
box remains unavailable until you fulfill all profile
requirements.

Users Select any number of users, from any group and role,
to be members of the signoff team. This is an ad hoc
selection method. You can also select resource pools.

If the Ad-hoc done check box is enabled at the bottom
of the Select Signoff Team dialog box, you can use this
selection method, regardless of whether you also use
the profiles and address list methods.

Address
lists

Select all the members of one or more address lists to
be members of the signoff team. You can also select
resource pools.

If the Ad-hoc done check box is enabled at the bottom
of the Select Signoff Team dialog box, you can use this
selection method, regardless of whether you also use
the profiles and ad hoc methods.
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Select a signoff team from profiles in Workflow Viewer

1. Select a select-signoff-team task that has reached Started status, either in the task hierarchy tree
or the process flow pane.

2. Review any task instructions written in the Instructions box at the bottom of the template
manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the select-
signoff-team task, you can create a subprocess from this task. The subprocess must complete
before the select-signoff-team task can complete.

4. Click Perform Task  on the toolbar or the button in the middle of the task in the process flow
pane.

The Select Signoff Team dialog box appears.

5. Expand the Profiles folder in the Signoff Team tree.

6. Select a profile. The Organization tab displays to the right, filtered to the group and role required
by the selected profile

7. Search or select a user from the Organization tree.

You can search for a specific user, group, role, or combination.

You can assign a resource pool to the task in Resource Pool Options.

8. Click Add to add the selected user to the signoff team.

The user name is added under the selected profile.

9. Repeat these steps to assign additional users to the signoff process. You must select the specified
number of users, of the specified group and role, for each profile.

For example, if the profile states: Engineering/Designer/3, you must select three users from the
Engineering group, with the role of Designer.

All profiles must be satisfied before the select-signoff-team task can complete.

10. (Optional) Type a description of the workflow process in the Process Description box.

11. (Optional) From the Review Quorum box, select the amount of users who must approve in order
for the task to complete. The initial setting is inherited from the process template. If you want to
change that setting, select a quorum using one of the following methods:

4. Selecting a signoff team
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• Select the Numeric option and type a number in the box.

• Select the Percent option and type a percentage in the box.

12. (Optional) Type any comments regarding the task in the Comments box.

13. If you want the workflow process to wait for all reviewers before continuing, select the Wait for
Undecided Reviewers check box.

14. Click Ad-hoc done to indicate you have completed adding signoff team members.

15. Click OK to complete the task and close the dialog box.

Select a signoff team ad hoc

1. Select a select-signoff-team task that has reached Started status, either in the task hierarchy tree
or the process flow pane.

2. Review any task instructions written in the Instructions box, at the bottom of the template
manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the select-
signoff-team task, you can create a subprocess from this task. The subprocess must complete
before the select-signoff-team task can complete.

4. Click Perform Task  on the toolbar.

The Select Signoff Team dialog box appears.

5. Click Users in the Signoff Team tree.

The Organization tab displays to the right.

6. Search and select a user from the Organization tree.

You can search for a specific user, group, role, or combination.

You can assign a resource pool to the task in the Resource Pool Options.

7. Click Add to add the selected user to the signoff team.

8. Repeat these steps to assign additional users to the signoff process.

9. (Optional) Type a description of the workflow process in the Process Description box.

Select a signoff team ad hoc
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10. (Optional) From the Review Quorum box, select the amount of users who must approve in order
for the task to complete. Select a quorum using one of the following methods:

• Select the Numeric option and type a number in the box.

• Select the Percent option and type a percentage in the box.

11. (Optional) Type any comments regarding the task in the Comments box.

12. If you want the workflow process to wait for all reviewers before continuing, select the Wait for
Undecided Reviewers check box.

13. Click Ad-hoc done to indicate you have completed adding signoff team members.

14. Click OK to complete the task and close the dialog box.

Select a signoff team from address lists in Workflow Viewer

1. Select a select-signoff-team task that has reached Started status, either in the task hierarchy tree
or the process flow pane.

2. Review any task instructions written in the Instructions box, at the bottom of the template
manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the select-
signoff-team task, you can create a subprocess from this task. The subprocess must complete
before the select-signoff-team task can complete.

4. Click Perform Task  on the toolbar.

The Select Signoff Team dialog box appears.

5. Click Address Lists in the Signoff Team tree.

The Address Lists tab displays to the right.

6. Select an address list from the list to display the members of the address list.

7. Click Add.

All members of the address list appears under Addresses in the Signoff Team tree.

8. Repeat these steps to add additional address lists.

9. (Optional) Type a description of the workflow process in the Process Description box.

4. Selecting a signoff team
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10. (Optional) From the Review Quorum box, select the amount of users who must approve in order
for the task to complete. Select a quorum using one of the following methods:

• Select the Numeric option and type a number in the box.

• Select the Percent option and type a percentage in the box.

11. (Optional) Type any comments regarding the task in the Comments box.

12. If you want the workflow process to wait for all reviewers before continuing, select the Wait for
Undecided Reviewers check box.

13. Click Ad-hoc done to indicate you have completed adding signoff team members.

14. Click OK to complete the task and close the dialog box.

View signoff team profiles in Workflow Viewer

1. In My Worklist, select a select-signoff-team task.

2. Choose View→Task Properties .

The system displays the Task Properties Dialog dialog box.

3. Click the Task Signoffs Panel  tab.

• The system opens the Signoff Profiles pane.

• The task breakdown tree displays the group/user profiles of the signoff team.

• The Signoff Quorum box displays the number of users who must sign off to complete the task.

4. Click Close.

View signoff team profiles in Workflow Viewer
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5. Signing off an Acknowledge or Review
task
Signing off an Acknowledge or Review task

To perform a signoff task, complete the selected perform-signoffs task in the task tree. There are two
types of perform-signoffs tasks:

• Review signoffs, with which you can elect to Approve, Reject, or make No Decision for the selected
task.

• Acknowledge signoffs, for which you can set the Acknowledged or No Decision value on the selected
task.

Only members of the signoff team can sign off a task.

Note:

Siemens Digital Industries Software recommends using your worklist in My Teamcenter to perform
signoffs, as the worklist is designed specifically for performing tasks. If you are a responsible party,
the Perform Signoff task is automatically sent to the Tasks to Perform folder in your worklist.

Information most pertinent to a signoff task is displayed in the Perform Signoff dialog box. The process
name, task name, and task state are listed at the top of the dialog box. View any comments and
instructions by clicking the respective links. Additional task information, such as task attributes, is
displayed in other dialog boxes.

Click any linked entry to display its related dialog box. For example, click a linked entry in the Decision
column to display the Signoff Decision dialog box and make your signoff decision.

Tool tips are available for each column in the dialog box. Activate the tool tips by moving your cursor
over each column.

Perform a signoff of an Acknowledge task in Workflow Viewer

1. Select the perform-signoffs task to be completed, either in the task hierarchy tree or the process
flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the perform-
signoffs task, you can create a subprocess from this task. The subprocess must complete before
the perform-signoffs task can complete.

3. Click Perform Task  on the toolbar.
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The Perform Signoff dialog box appears. The process name and task state appear at the top of the
dialog box.

4. Review the contents of the Process Description box. If necessary, type additional information into
the box.

5. If the Responsible Party entry contains a link, you can reassign the responsible party for this
signoff task.

a. Click the linked user name next to the Responsible Party entry.

The Assign Responsible Party dialog box appears.

b. The Organization and Project Teams tabs display the available groups, roles, and users to
which you can reassign the role of responsible party.

You can search for a specific user, group, role, or combination.

c. Select the desired group, role, or user and click OK.

The task is reassigned to the selected responsible party and the dialog box closes.

6. If the All Comments entry is linked, comments have been written regarding this signoff task. View
the comments by clicking the linked entry. The All Comments dialog box appears. Any comments
that have been written by yourself and other users are displayed within the text box.

7. View attachments to the workflow process by clicking the Attachments link.

The Attachments dialog box appears. Target and reference attachments are listed below the
signoff task in the task tree.

8. If the Instructions entry appears, instructions have been written for this signoff task. View the
instructions by clicking the linked entry.

The Instructions box appears. All task instructions are displayed within the text box.

9. (Optional) If you do not want to perform this signoff, delegate the signoff task to a different user.

a. Click on your user name in the User-Group/Role column.

The Delegate Signoff dialog box appears.

b. The Organization and Project Teams tabs display the available groups, roles, and users to
which you can delegate your signoff responsibility.

5. Signing off an Acknowledge or Review task

5-2  Workflows and Tasks on Rich Client, Teamcenter 2412
© 2025 Siemens



You can search for a specific user, group, role, or combination.

c. Select the desired group, role, or user and click OK.

Your signoff responsibility is delegated to the selected user and the dialog box closes. The
perform-signoffs task is removed from your worklist, and sent to the worklist of the selected
user.

Note:

Signoff responsibility can also be delegated by the responsible party, or a member of the
System Administration group.

10. Perform any signoff assigned to you. You can perform any entry in the Decision column that is
linked. Typically, you are only listed once. However, it is possible that you hold multiple entries
within the signoff team for various groups or roles.

a. Click a linked entry in the Decision column. By default, all entries begin as No Decision.

The Signoff Decision dialog box appears.

b. Select either Acknowledged or No Decision from the Decision section of the dialog box.

c. Type any comments regarding your in the Comments box. It is particularly useful to include
comments when you reject a signoff.

d. Click OK.

The signoff decision is recorded and the dialog box closes.

Note:

You must be a member of the group/role required by the signoff task to perform a signoff.
Whether you must also be currently logged on to that role, or may be logged on under
another group/role is determined by the SIGNOFF_required_group_and_role preference. If
this preference is changed from its default setting, you must be a registered member of the
signoff's required group and role, and you must be currently logged on as a member of that
group and role to perform the signoff. If this situation exists at your site, and if you are
logged on under another group/role, a Change User Setting notification appears:

Your current group/role does not match the required 
group/role --signoff group/signoff role Do 
you want to change your current user setting to --
signoff group/signoff role?

Perform a signoff of an Acknowledge task in Workflow Viewer
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signoff group/signoff role is the required group and role for the signoff task. Click Yes to
automatically change your user settings to the required group/role.

11. If user authentication is implemented for this signoff task, a password box appears in the Signoff
Decision dialog box, and your logon password is required to perform the signoff. If this situation
exists at your site, type your logon password in the Password box. This box appears only if user
authentication is required for the completion of this task. This functionality is determined by the
creator of the process template. It is implemented by attaching the EPM-require-authentication
handler to the signoff task.

12. Complete the signoff of this task by performing one of the following steps:

• Click OK to save the changes to the database and close the Signoff Decision dialog box.

• Click Cancel at any time to cancel the workflow process and exit the Signoff Decision dialog
box.

13. Click Close after you finish working with all the signoff information. The Perform Signoff dialog
box closes.

Sign off a Review task in Workflow Viewer

Information most pertinent to a signoff task is displayed in the Perform Signoff dialog box. The process
name, task name, and task state are listed at the top of the dialog box. View any comments and
instructions by clicking the respective links. Additional task information, such as task attributes, is
displayed in other dialog boxes.

Click any linked entry to display its related dialog box. For example, click a linked entry in the Decision
column to display the Signoff Decision dialog box and make your signoff decision.

Tool tips are available for each column in the dialog box. Activate the tool tips by moving your cursor
over the head of each column.

1. Select the signoff task to be completed, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the perform-
signoffs task, you can create a subprocess task can complete.

3. Click Perform Task  on the toolbar.

The Perform Signoff dialog box appears. The process name and task state appear at the top of the
dialog box.

4. Review the contents of the Process Description box. If necessary, type additional information into
the box.

5. Signing off an Acknowledge or Review task
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5. If the Responsible Party entry contains a link, you can reassign the responsible party for this
signoff task.

a. Click the linked user name next to the Responsible Party entry.

The Assign Responsible Party dialog box appears.

b. The Organization and Project Teams tabs display the available groups, roles, and users to
which you can reassign the role of responsible party.

You can search for a specific user, group, role, or combination.

c. Select the desired group, role, or user and click OK.

The task is reassigned to the selected responsible party and the dialog box closes.

6. If the All Comments entry is linked, comments have been written regarding this signoff task. View
the comments by clicking the linked entry.

The All Comments dialog box appears. Any comments that have yet been written by yourself and
other users are displayed within the text box.

7. View attachments to the workflow process by clicking the Attachments link.

The Attachments dialog box appears. Target and reference attachments are listed below the
signoff task in the Task tree.

8. If the Instructions entry appears, instructions have been written for this signoff task. View the
instructions by clicking the linked entry.

The Instructions box appears. All task instructions are displayed within the text box.

9. (Optional) If you do not want to perform this signoff, delegate the signoff task to a different user.

a. Click on your user name in the User-Group/Role column.

The Delegate Signoff dialog box appears.

b. The Organization and Project Teams tabs display the available groups, roles, and users to
which you can delegate your signoff responsibility.

You can search for a specific user, group, role, or combination.

c. Select the desired group, role, or user and click OK.

Sign off a Review task in Workflow Viewer
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Your signoff responsibility is delegated to the selected user and the dialog box closes. The
perform-signoffs task is removed from your worklist, and sent to the worklist of the selected
user.

Note:

Signoff responsibility can also be delegated by the responsible party, or a member of the
System Administration group.

10. Perform any signoff assigned to you. You can perform any entry in the Decision column that is
linked. Typically, you are only listed once. However, it is possible that you hold multiple entries
within the signoff team, for various groups or roles.

a. Click a linked entry in the Decision column. By default, all entries begin as No Decision.

The Signoff Decision dialog box appears.

b. Select either Approve, Reject, or No Decision from the Decision section of the dialog box.

• Choosing Approve performs a signoff of the task. The link in the Decision column changes
to green and reads Approve.

• Choosing Reject performs a signoff of the task. Your decision does not count towards the
quorum approval count required to complete the task. If the quorum requires all signoffs
to approve, your rejection stops the workflow process. The link in the Decision column
changes to red and reads Reject.

• Choosing No Decision allows you to abstain from the signoff of the task. No Decision is the
default setting for this dialog box. Your decision does not count towards the approval of the
task. The link in the Decision column changes to blue and reads No Decision.

c. Type any comments regarding your decision in the Comments box. It is particularly useful to
include comments when you reject a signoff.

If you want, you can also add a comment, but leave the decision set to No Decision.

d. Click OK.

The signoff decision is recorded and the dialog box closes.

Note:

You must be a member of the group/role required by the signoff task to perform a signoff.
Whether you must also be currently logged on to that role, or may be logged on under
another group/role is determined by the SIGNOFF_required_group_and_role preference. If
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this preference is changed from its default setting, you must be a registered member of the
signoff's required group and role, and you must be currently logged on as a member of that
group and role to perform the signoff. If this situation exists at your site, and if you are
logged on under another group/role, a Change User Setting notification appears:

Your current group/role does not match the required 
group/role --signoff group/signoff role Do 
you want to change your current user setting to --
signoff group/signoff role?

signoff group/signoff role is the required group and role for the signoff task. Click Yes to
automatically change your user settings to the required group/role.

11. If user authentication is implemented for this signoff task, a password box appears in the Signoff
Decision dialog box, and your password is required to perform the signoff. If this situation exists
at your site, type your password in the Password box. This box appears only if user authentication
is required for the completion of this task. This functionality is determined by the creator of the
process template. It is implemented by attaching the EPM-require-authentication handler to the
signoff task.

12. Complete the signoff of this task:

• Click OK to save the changes to the database and close the Signoff Decision dialog box.

• Click Cancel at any time to cancel the workflow process and exit the Signoff Decision dialog
box.

13. Click Close when you have finished working with all the signoff information.

The Perform Signoff dialog box closes.

Waiting for undecided reviewers

In a Review or Route task, when enough reviewers reject the task to prevent a quorum from being
reached, Teamcenter takes one of the following actions:

• If the Wait for Undecided Reviewers  check box was selected when the signoff team was selected,
the task is not rejected until all reviewers submit their decision. This is true even if enough reviewers
reject the task to prevent a quorum before all reviewers respond.

This allows all reviewers to give their input and early reviewers time to change their decision.
However, this may delay a time-sensitive workflow.

• If the Wait for Undecided Reviewers  check box on the task was cleared when the signoff team was
selected, the task is rejected immediately.

Waiting for undecided reviewers
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Reviewers who do not respond before the quorum is prevented do not have the opportunity to submit
a decision or their comments.

• If the EPM-demote-on-reject or EPM-suspend-on-reject handler is attached to the task, the task is
demoted or suspended immediately. The Wait for Undecided Reviewers check box is ignored.

5. Signing off an Acknowledge or Review task
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6. Determining the workflow’s status
Determining task type

Teamcenter provides different types of tasks to be used in workflow processes. Each type of task
performs specific behavior. For example, Do tasks relay instructions to selected users. The instructions
can be to send a shipment, mail a payroll, update a part design, or any other duty that is part of your
company's business processes.

Another example is the Review task, a container task that always contains the select-signoff-team and
the perform-signoffs tasks. The select-signoff-team task is sent to the worklist of the user responsible
for selecting the signoff team. By default, this is the process initiator. But the responsibility might be
configured differently at your site. The responsible party uses the select-signoff-team task to select
the group of users responsible for signing off the target objects of the workflow process. Then each
member of the signoff team receives the perform-signoffs task in their worklist. The perform-signoffs
task delivers Teamcenter objects (target objects) such as documents, design parts, and so on, to the
signoff team for review and required approval/rejection.

All of these types of tasks are interactive tasks.

Behavior Description

Interactive tasks Do tasks, Review tasks, and the select-signoff-team and perform-signoffs
tasks are a few examples of interactive tasks. You know a task is interactive
because it appears in the worklist of the user responsible for performing it.

Interactive tasks are performed by users. For example, Do tasks relay instructions
to selected users. The instructions can be to send a shipment, mail a payroll,
update a part design, or any other duty that is part of your company's business
processes.

Another example is the Review task, a container task that always contains the
select-signoff-team and the perform-signoffs tasks.

• The select-signoff-team task is sent to the worklist of the user responsible
for selecting the signoff team. By default, this is the process initiator, but the
responsibility may be configured differently at your site.

• The responsible party uses the select-signoff-team task to select the group of
users responsible for signing off the target objects of the workflow process.
Then each member of the signoff team receives the perform-signoffs task in
their worklist.
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Behavior Description

• The perform-signoffs task delivers Teamcenter objects (target objects) such
as documents, design parts, and so on, to the signoff team for review and
required approval/rejection.

Noninteractive
tasks

Other tasks are noninteractive. They are performed by the system in response
to handler settings, flow paths, and the results of interactive tasks. For example,
the Or task is used to unite alternate paths. This task is often placed near the
end of a workflow process to join together two or more branching paths. No user
interaction is required to complete an Or task.

Other noninteractive tasks include the Add Status and Validate tasks.

When you view workflow processes in Workflow Viewer you may see these tasks.
But users do not perform these tasks. Typically, they never displays in any users'
worklist.

Each type of task is identified by a symbol in the center of the task. The following table illustrates the
symbols of just a few of the types of tasks you see when viewing workflow processes in Workflow
Viewer.

Symbol Example Task name Description

Do Relays instructions to users to perform.

The yellow background of the task and
the symbol at the top-left corner of the
task indicate that the status of the task
in this example is Started.

Review Controls the selecting of the signoff
team, and delivers objects to the signoff
team for review.

This is a container task containing both
the select-signoff-team and perform-
signoffs tasks.

The green background of the task and
the symbol at the top-left corner of the
task indicate that the status of the task
in this example is Completed.

select-signoff-team Permits the process initiator to select
members of the signoff team.

This is a subtask of the Review task.

The yellow background of the task and
the symbol at the top-left corner of the
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Symbol Example Task name Description

task indicate that the status of the task
in this example is Started.

perform-signoffs Routes target items for members of the
signoff team to review, and collects their
approval or rejection.

This is a subtask of the Review task. It
always follows the select-signoff-team
task.

The gray background of the task and the
symbol at the top-left corner of the task
indicate that the status of the task in
this example is Pending.

Or Unites branching flow paths into a
single path.

The gray background of the task and the
symbol at the top-left corner of the task
indicate that the status of the task in
this example is Pending.

Task states

Each task within a workflow process is either Pending, Started, or Completed. The task's state displays
in the upper-left corner of the task.

• Task states control and coordinate execution of individual tasks in a process.

Tasks are always in one of the defined states.

• The symbol associated with each task state is displayed in the upper-left corner of the task box in the
process view.

State Symbol /
task tile

Description

Pending The task has not yet been started. A task cannot start
until the previous release level has completed.

Note:

If you see the  symbol instead, the task is
processing in the background.

Task states
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State Symbol /
task tile

Description

The gray background of the task and the symbol at the
top-left corner of the task indicate that the state of this
task is Pending.

Started The task is active and action can be taken.

The yellow background of the task and the symbol at the
top-left corner of the task indicate that the state of this
task is Started.

Completed The required actions have been performed. A completed
state for a Review task indicates that all signoffs have
been performed and the number of approvals are equal
to that specified in the quorum for the task.

The green background of the task and the symbol at the
top-left corner of the task indicate that the state of this
task is Completed.

Skipped The task has been skipped by a privileged user. If this is a
Review task, all signoff subtasks show the No Decision
symbol, indicating the tasks are skipped rather than
completed.

Failed A task’s state is set to Failed if the task is configured with
a failure path and if the failure conditions are met.

Note:

The Failed state does not appear on the Actions
menu, because it can only be triggered internally.

The red background of the task and the symbol at the
top-left corner of the task indicate that the status of this
task is Failed.

Suspended The task has been suspended. If this is a Review task, all
signoff tasks are removed from the inbox.

Unassigned The signoff team for a Review task has not yet been
assigned.

Aborted The task is canceled and the process is exited without
being completed.
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Note:

A completed state for a perform-signoff task means that all signoffs have been performed, and
the number of approvals are equal to the required number specified in the quorum for the task.

If the Wait For Undecided Reviewers check box is selected, the task completes when the last
reviewer approves or rejects the task. If the check box is not selected, the task completes as soon
as the quorum is satisfied.

View task attributes

1. Select the task or workflow process whose attributes you want to view.

2. Click Task Properties  on the toolbar.

The Task Properties dialog box displays the name of the selected process template or task template
in the Name box. Task instructions, if any, are displayed in the Instructions box.

3. Click the Attributes  tab at the bottom of the dialog box.

The Task Attributes pane appears.

• State displays the selected task's current state. A task's state changes as you and other
users proceed through workflow process activities such as performing signoffs. This cannot be
modified from this dialog box.

• Responsible Party displays the person responsible for the selected task. This cannot be modified
from the dialog box.

• Named ACL displays the named ACL assigned to this task, if any. This cannot be modified from
the dialog box; however, you can open the Named ACL dialog box for reference.

• Signoffs Quorum displays the number of signoffs required for a quorum to pass the selected
review task. This appears only when the selected task is either Select Signoff Team or Perform
Signoff. This cannot be modified from the dialog box.

• If a Condition task is selected, Condition Query displays the name of the assigned query.
If a query is not yet defined, only Condition Query displays. If a Condition task is selected,
Condition Result displays the result of the query, either True or False. If a query is not defined,
the result is listed as unset.

• The Due Date button displays when completion of the task is due. You can set or change the due
date in Workflow Viewer.

• The Duration box displays the length of time allowed for the completion of the project. You can
set or change the duration in Workflow Viewer when the selected task is in a Pending state.

View task attributes
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• The Recipients box displays the names of users selected to receive e-mail when the selected task
becomes overdue. You can set or change the recipients in Workflow Viewer.

4. Click Close.

Set due date in Workflow Viewer

Due Date displays the date when completion of the task is due. If the task is not complete by the
specified date, the task's status changes to late and the task becomes overdue. Overdue tasks display in
red in your worklist.

The default setting is No date set. The due date can be set from this dialog box.

1. Click the Due Date button.

The popup calendar displays the current month.

2. Enter the date using any of the following methods:

• Type a date directly in the box at the top.

• Type a year in the Year box to change it, scroll through previous or succeeding months using the
arrows, and click the desired date in the calendar display.

• Click the Today button.

3. Enter the hour, minute, and second of the task completion time to the left of the respective h:, m:,
and s: boxes. Base entries on a 24-hour clock. For example, enter 1:30 p.m. as 13 h: 30 m: 00 s.
Empty boxes automatically default to 0.

4. Choose one of the following:

• Click OK to save the changes to the database and close the popup calendar.

• Click Clear to clear all settings.

Note:

The amount of time it takes for a due date to reflect late status depends on the interval setting
defined for the Task Manager daemon. This daemon can be modified in the preference XML file by
editing the TASK_MONITOR_SLEEP_TIME value.

6. Determining the workflow’s status
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Note:

By default, any assigned user can change the due date on a task, but an administrator can
configure which users can set the due date.

For example, to specify that only the process owner can change due dates, the administrator can
set the following condition using the Business Modeler IDE.

Fnd0ManageDueDatePrivilege ( EPMTask o , UserSession u) := o.owning_user=u.user 

Set duration in Workflow Viewer

The Duration box displays the length of time allowed for the completion of the project. If the task is not
completed within the specified amount of time, the task's status changes to late and the task becomes
overdue. The duration length can be defined in the template of the selected task. The duration length
can also be defined in the Attributes dialog box when the selected task is in a Pending state.

Note:

The Task Manager daemon must be installed to see color-coding relating to task completion.

1. Click Set to the right of the Duration box.

The Set Duration dialog box appears.

2. Type an integer value for any or all of the following boxes to indicate the length of time that can
pass before the selected task needs to reach completion:

years
weeks
days
hours
minutes

3. Click one of the following buttons:

• Click OK to save the changes to the database and close the dialog box.

• Click Clear.

• Click Cancel at any time to close the dialog box without making any changes.

Set recipients list in Workflow Viewer

Recipients displays the names of users selected to receive program mail when the selected task
becomes overdue. The recipients list is set from this dialog box.

Set duration in Workflow Viewer
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1. Click Set to the right of the Recipients box.

The Select Recipients dialog box appears.

2. Enter the User, Group, or Address List search criteria for users you want to select.

3. Click User , Group , or Address List , based on the search criteria entered.

The search results appear in the box below. To display all users in the selected grouping, type * and
click the appropriate button. All users in the selected grouping display in the box below.

4. Select the users you want to define as recipients from the search results. You can choose multiple
users by pressing the control key and clicking the desired names.

5. Click the To button.

The selected users display in the box in the right side of the dialog box. These are the selected
recipients.

6. To delete a recipient, select the recipient and click the  button.

7. Click one of the following buttons:

• Click OK to save the changes to the database and close the dialog box.

• Click Cancel at any time to close the dialog box without making changes.

View task attachments

1. Click Task Properties  on the toolbar.

The Task Properties dialog box displays the name of the selected process template or task template
in the Name box. Task instructions, if any, are displayed in the Instructions box.

Note:

Displaying task instructions is dependent upon the WRKFLW_fnd0Instructions_available
preference. This preference enables the fnd0Instructions property in the style sheet by
default, disabling object_desc as a result. To display task instructions, administrators can
modify WRKFLW_fnd0Instructions_available as false, enabling the object_desc property in
the stylesheets.

2. Click the Attachments  tab at the bottom of the dialog box. The Task Attachments pane
appears.

6. Determining the workflow’s status
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The Task Attachments tree lists the Targets and References folders, which hold target and
reference attachments, respectively. The Replica Proposed Targets folder displays if replica
proposed targets exist.

3. Open, cut, copy, and paste attachments using the following methods:

• Click Open  to open the selected attachment in the appropriate rich client application.

• Click Cut  to cut the selected attachments to the clipboard.

• Click Copy  to copy the selected attachment to the clipboard.

• Click Paste  to paste the clipboard contents into the selected folder.

4. Click Close.

View task handlers

1. Click Task Properties  on the toolbar.

The Task Properties dialog box appears.

The name of the selected process template or task template is listed in the Name box. Task
instructions, if any, are displayed in the Instructions box.

2. Click the Handlers Pane  tab.

The Handlers pane appears.

3. Click the Expand All Folders  or Collapse All Folders  button to view the contents of the
Handlers Hierarchy tree.

Based on the type of handler selected, either the Rule Handler or Action Handler pane appears,
listing the name of the rule handler or action handler assigned to the selected task.

If the selected task involves selecting signoff teams or performing signoffs, a Quorum box contains
the number of approvals required for a quorum.

The arguments assigned to the selected task are in the Argument list.

4. Click Help for documentation on the selected handler.

5. Click Close to close the dialog box.

View task handlers

Workflows and Tasks on Rich Client, Teamcenter 2412  6-9
© 2025 Siemens



Modifying active workflow processes

Workflow Viewer allows privileged users to modify active workflow processes one template at a time.
Privileged users can add, remove, rearrange and modify tasks, flow paths, handlers, and other elements
of the workflow process template while workflow processes based on the template are running.

This functionality is called ad hoc process modification. It is available using the application's Design
mode.

Enable this functionality, and control user access, by setting the WORKFLOW_adhoc_process
preference. Access can be granted to all users, group administrators, and/or system administrators.

Note:

Alternatively, to update many active workflow processes simultaneously, use Workflow Designer.
You apply workflow template edits to all active workflow processes based on the previous
(unedited) version of the workflow template.

Ad hoc modification

Adding or deleting tasks from a workflow process while it is active is called ad hoc modification. In
Workflow Viewer, this ad hoc ability is possible whenever you are in Design mode.

To modify a task template, it must be in one of the following states:

Unassigned
Pending
Suspended
Completed

Note:

You can modify a Completed task only if the configuration of the template allows the task to
rerun, such as for backward-branching loops. The modification takes effect when the task is
restarted.

To modify a task, it cannot be in any of the following states:

Aborted
Failed

Note:

The Failed state does not appear on the Actions menu, because it can only be triggered
internally.

6. Determining the workflow’s status
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Skipped
Started

Note:

If you want to modify a Started task, you must suspend it first.

Edit an active workflow process

1. Open the active workflow process you want to edit in Workflow Viewer. Do so by locating an object
involved in the workflow process using one of the following methods:

• Select a task involved in the workflow process you want to edit from your worklist.

• Use Search to locate an object you know is involved in an active workflow process, or to search
for all objects currently in-process.

• Send an object you know is involved in an active workflow process to the Impact Analysis view
and perform a Where Referenced search to display all references to the object, including all
referenced workflow processes.

2. Right-click the object and choose Send To→Workflow Viewer. Or, if performing a Where
Referenced search, right-click the active workflow process and choose Send To→Workflow
Viewer.

The active workflow process is opened in Workflow Viewer.

3. If the task you want to edit is active, right-click the task and choose Actions→Suspend.

The Suspend Action Comments dialog box appears.

4. Type your comments into the dialog box. The comments are listed in the audit file.

5. Click OK.

The selected task moves to the Suspend state, and a red light button appears in the upper left
corner.

6. Choose Edit→Mode→Design to enable ad hoc functionality.

The following message appears:

Note that changing the Workflow Viewer Application mode 
to "Design" will lock this process, and allow you to modify the 
Process Structure and Handlers! Do you want to continue? 

Edit an active workflow process
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7. Click Yes to lock the selected workflow process within the database and proceed with modifying
the workflow process. No other users can perform tasks for this workflow process until you have
unlocked the workflow process by returning to Execute mode. Click No to discontinue without
making changes.

8. (Optional) Add, place, and remove tasks.

9. (Optional) Add, remove, and modify task attributes by clicking the Task Attributes  button.

10. (Optional) Add, remove, and modify task attachments by clicking the Task Attachments  button.

11. (Optional) Edit task handlers by clicking the Task Handlers  button.

12. (Optional) Edit perform signoff teams by clicking the Task Signoff  button.

Note:

Signoff profiles are unavailable for the Acknowledge subtask within the Route task template.
The Route task does not function properly if a signoff profile is defined for the Acknowledge
subtask. The Route task template is designed to be used as an electronic routing sheet, and
the workflow process initiator assigns specific signoff members.

13. Choose Edit→Mode→Execute to return to Execute mode.

The following message appears:

Note that changing the Workflow Viewer Application mode 
from "Design" to "Execute" will unlock this process. Do you want to 
commit any Design changes you made?

14. Click Yes to unlock the selected workflow process within the database. Any changes you made to
the workflow template are implemented.

Click No to unlock the selected workflow process within the database. Any changes you made to
the workflow template are not implemented.

Click Cancel to remain in Design mode.

15. If you suspended the task to edit it, right-click the task and choose Actions→Resume.

The Resume Action Comments dialog box appears.

a. Type your comments into the dialog box. The comments are listed in the audit file.

b. Click OK.

6. Determining the workflow’s status
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The selected task moves to the state it was in prior to the Suspend action.

Stopping a workflow process in Workflow Viewer

There are three ways to stop a workflow process in Workflow Viewer:

• Suspend

Stops the process from moving forward. Choose Actions→Suspend. You can resume a suspended
process by choosing Actions→Resume.

• Abort

Cancels the process, but keeps the process in the system. Choose Actions→Abort.

• Delete

Removes the process from the system. Choose Edit→Delete.

If you have a subprocess attached to your workflow process, the following rules apply when you delete
or abort the parent process or subprocess:

• Delete or abort the parent process.

• If the parent process is the only parent for the subprocess, the subprocess is also deleted or
aborted.

• If there is more than one parent process for the subprocess, the subprocess is not deleted nor
aborted unless it is the last parent process.

• Delete or abort a subprocess—the parent process is kept and continues.

• Delete the task in the parent process that originates the subprocess—the subprocess is not affected.

• If the subprocess has its own subprocess, it follows the rules above.

Note:

Workflow subprocesses can be dependent or independent of parent processes, depending on the
preference.

Independent of parent process

The WRKFLW_skip_abort_on_sub_process preference is honored only for independent
subprocesses.

Stopping a workflow process in Workflow Viewer
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Set the WRKFLW_skip_abort_on_sub_process preference to true to skip abort of subprocess
when a parent process is aborted.

Dependent upon parent process

If there is a dependency from a parent process to its subprocesses, aborting the
parent will abort the dependent subprocesses, irrespective of the value of the
WRKFLW_skip_abort_on_sub_process preference.

The default value of WRKFLW_skip_abort_on_sub_process is false which will abort the
subprocesses along with parent process.

The WRKFLW_parent_behavior_on_sub_process_abort preference ensures the parent process's
task proceeds after the dependent subprocess is aborted.

6. Determining the workflow’s status
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7. Changing a task’s state
Overriding task actions

As you work through a workflow process in Workflow Viewer, a task's actions work behind the scenes,
transitioning the task from one state to another according to the actions defined in the task. You can
override the task's defined actions, if necessary.

For example, the Start action is always used to transition a task from the Pending state to the Started
state.

All tasks are transitioned by one or more of the following defined actions:

Abort
Assign
Complete
Perform
Resume
Skip
Start
Suspend
Undo
Failed

Note:

The Failed state does not appear on the Actions menu, because it can only be triggered internally.

When a task's template is created in Workflow Designer, one or more actions become part of the task's
definition. As you work through a workflow process in Workflow Viewer, a task's actions work behind the
scenes, transitioning the task from one state to another according to the actions defined in the task.

If a task is designated to process in the background, all actions except Perform and Assign are processed
in the background. The Perform and Assign action execute in the foreground.

However, there are some situations where it is necessary to override the task's defined actions. For
example, if a task is demoted, the workflow process moves backward to the preceding task. If the
preceding task has an EPM-demote handler, it is automatically initiated. But if the preceding task does
not have an EPM-demote handler, the task must be initiated manually. Thus, the responsible party or a
privileged user must manually override the preceding task's defined action and change the task state to
Start.

Several of these actions are used to place the task in a special state such as Suspended or Skipped. Not
all tasks use all actions. The following figure shows the EPM task actions and corresponding states.
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In addition to task transition, from one state to another, actions are also used to implement rules. This
is done by attaching one or more handlers to an action. There is one action, Perform, that does not
transition a task to another state. The Perform action executes any handlers attached to it and displays
an interactive panel.

All tasks require resources to perform actions. Resources are one of the following object types:

Groups
Roles
Users

7. Changing a task’s state
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Complete a task with attached form

If a simple form is assigned as the Perform action for a task and it is not specialized to initiate a
Complete action, the task does not complete automatically. When the form completes, the responsible
party or a privileged user with bypass ability must manually signify that the associated task is complete
by using the Complete action.

Note:

To perform this action, you must be the responsible party or a privileged user.

1. Click the desired task with the completed form. All of the actions for this task must have been
completed.

2. Choose Actions→Complete.

The Complete Action Comments dialog box appears.

3. Type your comments in the dialog box.

The comments are listed in the audit file.

4. Click OK.

The selected task moves to the Complete state and the button of a flag appears in the upper left
corner. The succeeding task switches to Start.

Note:

If a task is designated to process in the background, the move to the Complete state might
be delayed.

Starting a paused task

In rare cases, tasks become stalled and must be initiated manually.

To reset the tasks to Start, the responsible party or a privileged user with bypass ability can instruct the
tasks to move to a new state by performing a Start action on the task.

Note:

• To perform this action, you must be the responsible party or a privileged user.

Complete a task with attached form
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• If a task is designated to process in the background, the move to the Complete state might be
delayed.

Reset a paused task

1. Click the task that has stalled.

2. Choose Actions→Start.

The Start Action Comments dialog box appears.

3. Enter your comments into the dialog box. The comments are listed in the audit file.

4. Click OK.

The selected task moves to the Start state and the button of a green light appears in the upper left
corner.

Note:

If a task is designated to process in the background, the move to the Start state might be
delayed.

Suspend a task

1. Select the task you want to suspend.

Note:

You must be the responsible party or a privileged user to suspend a task.

2. Choose Actions→Suspend.

The Suspend Action Comments dialog box appears.

3. Type your comments into the dialog box. The comments are listed in the audit file.

4. Click OK.

The selected task moves to the Suspend state, and a red light button appears in the upper left
corner.

7. Changing a task’s state
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Note:

If a task is designated to process in the background, the move to the Suspend state might be
delayed.

Resume a task

1. Select the desired suspended task.

Note:

The only valid action for a suspended task is Resume. You must be the responsible party or a
privileged user to resume a task.

2. Choose Actions→Resume.

The Resume Action Comments dialog box appears.

3. Type your comments into the dialog box. The comments are listed in the audit file.

4. Click OK.

The selected task moves to the state it was in prior to the Suspend action.

Note:

If a task is designated to process in the background, the move to the prior state might be
delayed.

Skip a task in a process and start the next one

The Promote menu command moves the task to a Skipped state and starts the successor tasks in the
workflow process.

Workflow Viewer treats a Skipped task much like a Completed task.

Note:

To perform this action, you must be a privileged user.

1. Select the task you want to promote.

2. Choose Actions→Promote.

Resume a task
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The Promote Action Comments dialog box appears.

3. Enter your comments into the dialog box.

4. If the task is a Review or Route task and it has a reject path, click either the Approve or Reject
decision to determine the path you want the workflow process to follow.

This helps you to expedite the review process where you want to move the workflow process along
despite rejections.

5. Click OK.

The selected task moves to the Skipped state and the next task in the process is started. The comments
you entered are listed in the audit file.

Note:

If a task is designated to process in the background, the move to the Skipped state may be
delayed.

Demote a task

The Demote menu command is the method of moving an active workflow process back to some
predefined release level. Performing a demote action upon a task changes the task's state from Started
to Pending. The specific demote behavior of any given task is configured within the original process
template. For subtasks to also demote when a parent task is demoted, the EPM-demote handler must
be applied to the task's Undo action when the process template is configured. Demoting a Review
task removes any signoff decisions previously made by members of the task's signoff team, but any
comments are kept.

Note:

To perform this action, you must be a privileged user.

1. Select the task you want to demote.

2. Choose Actions→Demote.

The Demote Action Comments dialog box appears.

3. Type your comments into the dialog box.

The comments are listed in the audit file.

4. Click OK.

7. Changing a task’s state
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The selected task moves to the designated state.

Note:

If a task is designated to process in the background, the move to the designated state might be
delayed.

Demote a task
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8. View audit information
Accessing audit information

You can access audit information in the following ways:

• Go to the Summary view of the following Teamcenter applications, which shows audit logs in the
Audit logs tab.

• My Teamcenter

• ADA License

• Structure Manager

• Multi-Structure Manager

• Manufacturing Process Planner

• Schedule Manager

• Workflow Viewer

• Organization

• Run predefined audit reports or create new reports, using the Report Builder application.

• Create custom saved queries, using the Query Builder application.

• Run predefined audit queries, using the Teamcenter advanced search functionality.

Accessing and viewing audit information

Legacy audit information is only accessible from a button in the Audit Logs tab in the Summary view
when a legacy audit file is present.
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The audit logs are grouped in the Summary view as follows:

Log name Description

Workflow Logs Displays workflow logs.

License Change Logs Displays logs of ADA License changes.

License Export Logs Displays ADA License export logs.

File Access Logs Displays file access logs.

Structure Logs Displays structure logs.

Note:

Due to performance reasons, PSOccurence
audit logs are not immediately displayed
in the Structure Logs table. To view the
PSOccurence audit logs, refresh the table.

Organization Logs Displays organization logs.

Schedule Logs Displays schedule logs.

General Logs Displays all other general audit logs.

Security Logs Displays security logs.

Note:

The Security Logs table appears in the Audit
Logs Summary tab for Project, User, and
Group objects.

8. View audit information
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Creating and running audit queries

You can create custom search queries for audit logs, using the Query Builder application. Saved queries
identify the search criteria that are used to find information in Teamcenter.

Note:

Ensure that audit definitions exist for the objects for which you have created saved queries.

Teamcenter provides the following predefined audit queries:

• Audit - Digital Signature Logs

• Audit - File Access Logs

• Audit - General Logs

• Audit - License Change Logs

• Audit - License Export Logs

• Audit - Organization Logs

• Audit - Project Based Logs

• Audit - Schedule Logs

• Audit - Security Logs

• Audit - Structure Logs

• Audit - Workflow Attachment Logs

• Audit - Workflow Detailed

• Audit - Workflow General

• Audit - Workflow Signoff

• Audit - Workflow Summary

Export audit logs to Microsoft Excel

The Export to Excel option is available on Windows clients. Microsoft Excel must be installed on your
computer to export audit logs to Excel.

Creating and running audit queries
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1. Run a saved query and choose the audit logs you want to export from the Details tab.

2. Choose Tools→Export→Objects To Excel.

Teamcenter displays the Export To Excel dialog box.

3. Under Object Selection, click one of the following:

• Click Export Selected Objects to export the selected rows in the view.

• Click Export All Objects in View to export all rows.

4. Under Output Template, select one of the following:

• Select Export All Visible Columns to export all the columns in the view.

• Select Use Excel Template to activate the template list.

In the list, select the AUDIT_log_export_template_new template.

5. Under Output, click Static Snapshot.

6. Click OK to generate the export Excel file.

Microsoft Excel opens a temporary file. You can create a permanent file by choosing File→Save As in
Excel to display the Save As dialog box.

If you save a live Excel file, you can open it later in My Teamcenter to reconnect it to the database. Values
that you cannot change in Teamcenter are unavailable in the cells of the live Excel file.

View legacy audit log information

Note:

This data is available only if the TC_audit_manager preference is set to ON and the
TC_audit_manager_version preference is set to 2.

1. (Optional) Select an object in the tree.

2. Choose View→Audit→View Audit Logs.

OR

Right-click an object in My Teamcenter and choose View Audit Logs.

8. View audit information
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The system displays the Audit Log dialog box.

• If you select an object, the object ID, name, revision, and object type are displayed in the Search
Criteria section.

• To select a project, select a project you have access to from the Project list.

• If you want to search for a different object, click the Clear button to clear the existing search
criteria and then type the object ID, name, and revision in the Audit Log dialog box.

3. (Optional) Specify additional search criteria, such as event type, user ID, and date created.

4. (Optional) Click the Advanced tab and type criteria to construct a query based on property values.

Note:

The Advanced tab does not display any information if there are no logged properties in the
audit definition object.

a. Select an object type from the Object Type list.

View legacy audit log information
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After you select an object type, the Event Type list is enabled.

b. Select an event type from the Event Type list.

The logged properties defined in the audit definition object are shown in the Available
Properties list.

c. Select the properties for which you require audit logs from the Available Properties list, and
click the  button to move the property to the Selected Search Criteria list.

Note:

You can add up to 20 properties in the Selected Search Criteria list.

d. To search for properties based on old or new values, in the Selected Search Criteria list, enter
the old value in the Old Value column and the new value in the New Value column.

e. Click Find.

Audit logs that match your selected criteria appear.

5. Click Find.

The system displays the audit logs that match the search criteria.

8. View audit information
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Property value changes are shown in the User Data column of the audit log. The User Data
column shows the property name, the old value of the property, and the new value of the property.

The old value of the property is the same as the new value of the property if the property value
does not change.

Note:

Only persistent properties of objects are tracked. Run-time, compound, and relational
properties are not tracked by Audit Manager.

View legacy audit log information
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9. Viewing workflow and schedule progress
Reviewing workflow and schedule progress by viewing the process
history

The Process History view displays the Workflow or Schedule Manager process of the business object
selected in the Home, My Worklist, or Search Results view in My Teamcenter.

• If there is no audit data for the business object, the view displays a No process history data
available for selected object. message.

• If the selected object has passed through more than one workflow process, you can choose which
process to display from the list to the right of the tab.

In the Process History view, you can review the progress of a workflow or schedule and do the
following:

• Determine the progress of an object in a schedule or workflow and who has responsibility for the
object.

• Review comments by other workflow participants.

• Verify that the appropriate participants completed the required reviews.

• Debug a workflow that proceeded down an unexpected path.

• Identify workflows that require attention to continue processing.
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• Review user activity to verify the appropriate users signed off.

Note:

If you migrate from Audit Manager version 2 to version 3, workflow-related events are migrated
and are displayed in the Audit Logs tab. However, the events are not displayed in the Process
History view.

Tip:

Administrators can configure display of the Target Release Status values in the Process History
view.

• Target Release Status values are only shown by the Process History view for a selected object.

• Target Release Status is not shown in the Process History view for a workflow or task.

Customize the process history display

1. In the Process History view, click the View Menu button  and then choose Column from the
view menu.

The Column Management dialog box appears.

2. Add or remove columns from the Process History view table.

• To add a column, select a property from the Available Properties list and click the Add to
Displayed Columns button .

• To remove a column, select a property in the Displayed Columns list and click the Remove from
Displayed Columns button .

3. (Optional) Click the Move Up  and Move Down  buttons, to the right of the Displayed
Columns list, to adjust the order of the displayed columns.

4. Click Apply to apply the configuration to the current view, or click Save to save the configuration
for later use.

Note:

You can use the Apply Column Configuration command on the view menu to:

9. Viewing workflow and schedule progress
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• Apply a saved configuration.

• Restore the default configuration. This is the only way to restore columns removed using
the right-click Remove this column command.

You can use the Save Column Configuration command on the view menu to save the
current configuration of the table display.

5. Click Close to close the Column Management dialog box.

View and print process reports

On My Teamcenter, choose Tools→Reports→Report Builder Reports, and then choose one of the
following audit reports:

• Audit - Workflow Attachment Report

Displays all attachment object details for the specified workflow process.

• Audit - Workflow Detailed Report

Displays all actions and their statuses for the specified workflow process.

• Audit - Workflow Signoff Report

Displays the signoff results and comments for the specified object in a workflow process.

• Audit - Workflow Summary Report

Displays the start, complete, approve, rejected, assign status, demote, promote, fail, and update
actions for the specified workflow process.

• WF - Items In Process

Displays the items currently in a workflow process and where they are in their respective processes.

• WF - Objects In Process

Displays the objects currently in a workflow process and where they are in their respective processes.

To print a process history report:

1. Export the audit report to Excel.

2. Use the Excel print function to print the report.

View and print process reports
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Print the process history report

1. Export the audit report to Excel.

2. Use the Excel print function to print the report.

Export audit logs or process history to Microsoft Excel

Teamcenter contains Extensions for Microsoft Office (also known as live Excel) which allows you to
manage Teamcenter objects and properties from Microsoft Excel.

1. Display the Process History view and choose the rows you want to export.

OR

Run a saved query and select the audit logs you want to export from the Details tab.

Note:

You can only run a saved query from My Teamcenter. The saved query functionality is meant
to be executed only when the Schedule tasks folder is expanded in My Worklist. You cannot
run this query from anywhere else in the system.

2. Choose Tools→Export→Objects To Excel.

Teamcenter displays the Export To Excel dialog box.

3. Under Object Selection, select one of the following:

• Select Export Selected Objects to export the rows you selected in the view.

• Select Export All Objects in View to export all rows.

4. Under Output Template, select one of the following:

• Select Export All Visible Columns to export all the columns in the view.

• Select Use Excel Template to activate the template list.

In the list, select the template that specifies the data that you want to export.

5. Under Output, select one of the following:

• For a standard Excel file that is not connected to Teamcenter, select Static Snapshot.

9. Viewing workflow and schedule progress
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• For an interactive live Excel file that is connected to Teamcenter, select Live integration with
Excel (Interactive).

• For a live Excel file that is not connected to Teamcenter, select Live integration with Excel (Bulk
Mode).

You can accumulate changes and later connect the file to Teamcenter.

• To export the data to an Excel file that also contains import processing information on a separate
sheet, select Work Offline and Import.

• To check out objects while exporting to live Excel, select Check out objects before export.

Note:

The checkout applies to all objects being exported. Use this option carefully if you are
exporting a large number of rows.

6. (Optional) Click Copy URL.

Note:

• Copy URL is unavailable if you select more than one object to export.

• Copy URL is unavailable if you select any of the following dialog box options:

• Work Offline and Import

• Export All Visible Columns

• Export All Objects in View

The export file is generated and the URL Generated message is displayed, confirming that the
URL is in your Windows Clipboard and showing the URL details.

7. Click OK to generate the export Excel file.

Excel opens a temporary file. You can create a permanent file by choosing File→Save As in Excel to
display the Save As dialog box.

If you save a live Excel file, you can open it later in My Teamcenter to reconnect it to the database.

Note:

Values that you cannot change in Teamcenter are unavailable in the cells of the live Excel file.

Export audit logs or process history to Microsoft Excel
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